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ANYONE WILL FIND THIS BOOK HELPFUL

Welcome to the Graphic Designer’s Digital Toolkit! Here you will learn the essential 
skills and design techniques to get you comfortable using the newest versions of 
the premier graphics programs in the industry today: Photoshop, Illustrator, and 
InDesign. This book is set up as a challenging hands-on, project-based classroom 
book with which students will complete useful, real-world projects from start to 
fi nished product in a structured format that a designer would normally create for 
a client. All fi les used for all exercises can be downloaded from the publisher’s 
website at www.cengagebrain.com; downloading these is also one of the fi rst 
exercises in Chapter 1. The tutorials are set for the user to start from concept to 
completion. This book also contains terminology or language used in the graphics 
today to give the learner an understanding of terms and techniques. It is created for 
college students who are taking introductory to intermediate classes in computer 
graphics applications, digital media, graphic design, or as a supplementary text 
providing projects for courses in Photoshop, Illustrator, and InDesign. Many col-
leges have adopted the text as the main text directly for multiple courses in digital 
imaging, digital illustration, digital (desktop) publication, digital media, or graphic 
design instead of purchasing different books for each course. It can also be used for 
a half-year course in digital media for college-bound upper-class students at the 
high school level, and can be used not only in the traditional classroom, but in 
hybrid and online courses as well.

For the professional who may need a refresher course in one or more of the appli-
cations, or for the individual looking for an edge in making a career change into 
the graphics industry, this book can be used as a self-paced study. It also makes a 
great reference text for professionals already in the fi eld. The business owner who 
wants to create his or her own logo, business cards, promotional pieces, advertise-
ments, newsletters, and brochures or to adjust and retouch a photograph can also 
use this book. 

EMERGING TRENDS

With new versions of applications coming out constantly, most individuals do not 
need to learn every function and command, but they can learn the most essential 
of these to be productive in creating most types of projects. This is the focus of 
the book: to make the reader comfortable in each graphic application to be able 
to create the projects that a designer might be asked to produce, and to speak 
the language used in the graphics industry today. Current new important useful 
tools, processes, and techniques are used realistically in each application and are 
integrated in each chapter tutorial.

BACKGROUND OF THIS TEXT

After spending many years as an instructor and Program Chair at the college 
level and evaluating books to be used by faculty, I was disappointed by the lack 
of depth in many of the project-based learning books. I also could not fi nd a 
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suitable book that was an introduction to the major graphic applications used in 
the industry today—Photoshop, Illustrator, and InDesign—and how they are used 
individually and together in creating quality projects. I wanted to design a book 
that not only addresses the essential skills a designer would need in each applica-
tion without having to be bombarded with countless commands and functions 
that may never be used, but a book that also shows the design process involved in 
creating a project from start to fi nish, and the language of the graphics industry. 
Each hands-on project in this book builds upon the functions of select tools and 
commands with basic, similar concepts to show the reader what happens in the 
real world of graphics. This book assumes the reader knows the basics of working 
with computers.

TEXTBOOK ORGANIZATION

Welcome to a project-oriented, real-world approach to learning the three cate-
gories of graphics applications used in the industry today. Specifi cally, this book 
focuses on Adobe Photoshop for digital image editing, Adobe Illustrator for digi-
tal illustration, and Adobe InDesign for digital desktop publishing as the stan-
dards in their respective fi elds. Before introducing these applications, the book 
provides a foundation of Macintosh OS X Marvericks, and Windows 7 and 8 
computer operations, terminology, and design elements, principles, typogra-
phy, imagery, and color concepts, along with an understanding of the process 
of design from concept to completion in the fi rst two chapters. Each chapter 
provides insight on the design fundamentals, terminology, and technical aspects 
that a designer needs to know for each application. Although the book uses the 
newest versions of each program, previous versions are also explained in many 
cases. The projects and information given for each application provide the essen-
tial skills a designer needs to feel comfortable using that application, no matter 
what version they are working with. The text then provides the added demon-
strated knowledge of current new tools, techniques, and processes that may be 
useful in their everyday work fl ow by showing how they are integrated in each 
chapter tutorial and exercise. This book can be used with either Macintosh or 
Windows computers. 

The book is divided into four units, and each unit is divided into chapters with 
projects or assignments a designer could actually create for a client from concept 
to fi nal completion for print or web media. Each chapter builds upon skills learned 
from the previous chapter to enhance the learning process. You will walk through 
and create a project from each chapter assignment using the necessary online fi les 
(which can be downloaded from the publisher’s website at www.cengagebrain.com), 
learning the process from concept to completion of the project, including techni-
cal “Toolkit Tip” suggestions, special design tips, and help on what to do if you 
run into a specifi c problem. 

The fi rst unit, Getting Ready for Production, focuses on getting comfortable using 
both Macintosh and Windows computers and understanding the design princi-
ples and elements that go into the creation of a good design. The other three 
units are set for each of the three graphic applications: Photoshop, Illustrator, 
and InDesign. In each chapter, there is also an Advanced Users section to fur-
ther challenge the learner and a Digital Toolkit Extra section for mini projects to 
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demonstrate additional concepts or techniques. At the end of each chapter are 
review questions that could also serve as a chapter quiz to test the reader’s knowl-
edge of fundamental material. Each unit contains a Unit Review Project Challenge 
that ties together all the chapters within the unit and provides a few additional 
functions, tools, and techniques to explore. 

In the fi rst unit, Getting Ready for Production, you will become familiar with both 
Macintosh OS X and Windows 7 and 8 environments, managing fi les and folders, 
creating shortcuts, learning keyboard shortcuts, creating electronic slide shows, 
using widgets (Mac), using iTunes, setting up for online with iCloud, fun tools and 
techniques for organizing your desktop, and burning data, music, and photo CDs. 
You will also be exposed to design elements and principles, typography basics, 
imagery basics, and understanding color and how to use color to create posters. 

In the second unit on Photoshop CC, assignments involve adjusting poorly exposed 
or badly colored graphics, using Adobe Bridge and Mini Bridge to locate and man-
age fi les, completely changing the color of a sports car image for a realistic effect 
using selection techniques, creating a well-toned black-and-white image from a 
color image, creating a black and white and color composite image, using actions to 
create special effects and copyright info, fi xing off-color images, combining images 
into one suitable image using layer techniques, digitally restoring an old image, 
creating a multicolor product ad from a single product, and combing images and 
special techniques to create a realistic front and back cover for a music CD. Other 
tutorials involve working in 3D with text and creating 3D shapes, color replacement 
in products, managing fi les and application settings online using Creative Cloud, 
adjusting an image’s vantage point, and working with shapes in creating a basic 
fi gure illustration. You will also learn about working with camera raw fi les as the 
new digital negative from digital cameras.

In the Illustrator CC unit, you will create an electronic game board, a 3D wine 
bottle with a perfectly fi t label, special design symbols, a logo, playing cards, 
company business cards with logo, a clock face, and a tourism map, as well as 
create an advanced fi gure illustration, sync fi les and application settings between 
multiple computers, and using actions for repetitive projects like laying out 
eight business cards on a sheet. You will also create radio station web banners 
that combine both Photoshop and Illustrator images, and a promotional label 
on a 3D mug. You will also learn to use the Image Trace and Live Paint features, 
and creating multiple artboards using one logo for various media.

The fourth and fi nal unit demonstrates how to use InDesign CC as a desktop pub-
lishing tool. It provides assignments in creating a direct mail coupon ad, a photo or 
art desktop calendar, a four-page newsletter, interactive PDF documents, develop-
ing alternate layouts for digital devices and print sizes using the same design, and 
a tri-fold brochure to get you right into the most familiar projects a designer might 
fi nd, along with an understanding of the process from  prefl ighting or checking 
documents and graphics to packaging your project for the service provider.

You will fi nd many of these same projects coming up in your design career. Enjoy 
the ride! 

Copyright 2015 Cengage Learning. All Rights Reserved. May not be copied, scanned, or duplicated, in whole or in part. Due to electronic rights, some third party content may be suppressed from the eBook and/or eChapter(s).

Editorial review has deemed that any suppressed content does not materially affect the overall learning experience. Cengage Learning reserves the right to remove additional content at any time if subsequent rights restrictions require it.



ALL STUDENT FILES FOR ALL TUTORIALS CAN BE 
DOWNLOADED ONLINE

Online at www.cengagebrain.com, you will fi nd all image and text fi les used in 
all the assignments and projects. You will fi nd some extra goodies like additional 
information, more projects (yes, more!), and resource information that may be 
useful, too, in the “Extras & Goodies” folder online. To access the online fi les for 
this book, take the following steps:

 1. Open your browser and go to the publisher’s website at http://www
. cengagebrain.com 

 2.  Type the author, title, or ISBN of this book in the Search window. (The ISBN 
is listed on the back cover.)

 3.  Click the book title in the list of search results.

 4.  When the book’s main page is displayed, click the Access Now button under 
the Free Materials tab.

 5.  To download fi les, select a chapter number and then click on the Student 
Files tab on the left navigation bar to download the fi les.

 6.  To access additional material, click the Extras & Goodies link next to the 
Student Data Files link to download the fi les. For those not very comfortable 
with downloading material, there is also a detailed exercise in Chapter 1 on 
the process.

FEATURES

The following list provides some of the salient features of the text:

• Over 50 projects and tutorials in the text, more additional projects, tutorials, 
and info in the online Extras & Goodies folder.

• Objectives clearly state the learning goals of each chapter.

• All fi les needed for projects are included online at www.cengagebrain.com for 
download.

• Client Assignments involve multiple tools and techniques and resemble those 
that a designer might encounter on the job to complete a useful project. 

• Toolkit Tips in each chapter explain tools and techniques and additional info.

• Design Tips in each chapter show how to master design fundamentals with 
each software application.

• Digital Toolkit Extra and Advanced Users sections at the end of each chap-
ter provide added challenges and additional tools, techniques, and mini 
projects.

• Review questions reinforce material presented in the each chapter.
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• Unit Review Project Challenges tie together all the chapters within the unit 
and provide a few additional functions or techniques to explore. 

• All kinds of terms used in the graphics industry today so you can understand 
the designer’s lingo.

The Graphic Designer’s Digital Toolkit, 7e includes a CourseMate, which helps you 
make the grade!

This CourseMate includes:

• An interactive eBook, with highlighting, note-taking, and search capabilities

• Interactive learning tools including:

° Chapter quizzes

° Flashcards

° Crossword Puzzles

° And more!

Go to login.cengagebrain.com to access these resources.

NEW TO EDITION
• Text provides a comprehensive overview of new functions, tools, techniques, 

and panels used in Adobe Illustrator CC, Adobe InDesign CC, and Adobe 
Photoshop CC. Many additional tutorials have been added in the Advanced 
Users and Digital Toolkit Extra sections and new images have been added to 
replace others in some of the tutorials for a refreshing look.

• Nearly all fi gure artwork is updated to the current Macintosh, Windows 7, and 
Windows 8 operating systems in Chapter 1, and to the Adobe Creative Cloud 
format, with over 700 fi gures redesigned to meet the new darker interface 
for Illustrator, Photoshop, and InDesign and for even better comprehension 
for the user. New current menus, tools, techniques, and additional tutorials 
using Adobe Creative Cloud applications Photoshop CC, Illustrator CC, and 
InDesign CC. Updated Windows 7 and Mac OS X Mavericks operating sys-
tems, and an all new section in using the Windows 8 operating system.

• Navigating the Macintosh OS X Mavericks desktop and having fun organi-
zing and playing on your desktop using Widgets, Launchpad, Mission Control, 
iCloud, iTunes, and Dashboard programs. Using Tabs and Tags to organize your 
fi les. Electronic slide shows using Quick Look and Preview.

• Updated end-of-chapter projects will help reinforce tools and techniques 
taught throughout each chapter.

• The reader will fi nd complete tutorials in using Windows 8 with its Start Screen 
of tiles and apps, ribbon interface, navigation, and organization. Updated 
Windows 7 techniques provided and comparisons made between Windows 7 
and 8. Electronic slide shows using Pictures Library, Photos App (Windows 8), 
and Windows Media Center are also updated.
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• There are new images, tutorials, and projects offered in the Photoshop CC 
unit. Updated tutorials of new masking techniques and selection tech-
nologies with the Refine Edge function, the Properties panel, along with 
various color and black and white presets and enhancements. Additional 
tutorials include adjusting vantage points with the Perspective Warp func-
tion, managing and syncing files and settings using Creative Cloud, and 
moving subjects with Content Move for precise blending. Additional tuto-
rials involving tools not discussed in previous editions are introduced like 
using the Color Replacement and Eyedropper tools to sample and replace 
colors in products, and as corrective tools in removing stains and rust in 
architecture, along with creating shapes on different layers in the develop-
ment of a basic figure diagram. There are updated exercises on enhanced 
Camera Raw effects, and using the new Camera Raw Filter with new 
images. Finally, a large tutorial in creating and working with 3D text and 
shapes in creating special materials-based objects that can be ready for 3D 
print. 

• Illustrator CC showcases reconstructed Pen, Pencil, Smooth and Direct 
Selection Tools. The Pen and Direct Selection tools have a Path Segment 
Reshape function for precise curve adjustment. There is also a Live Corners 
function used with the Direct Selection Tool for creating precise curves from 
corner points. There is the ability to convert text into individual objects with 
the new Touch Type Tool, and updates with color and swatches, panels, pack-
aging, and creating smart objects. Additional tutorials involve creating an 
advanced fi gure illustration that showcases the Live Corners feature, syncing 
fi les and settings in Creative Cloud, and creating an action to convert one 
business card into a layout of eight business cards on a sheet.

• InDesign CC fi gure artwork has been updated to accommodate the current 
dark interface preferred by professionals using Adobe Photoshop CC and 
Illustrator CC for consistency. InDesign CC contains many new features that 
help in production workfl ow. Exploring enhanced font management tech-
niques, syncing fi les and settings, generating QR codes, color and packag-
ing updates, and EPUB updates. There is the ability to work seamlessly with 
integration of hyperlinks and create scalable effects. 

• Additional tutorials and handouts are also offered in the Extras & Goodies folder 
that can be found online at www.cengagebrain.com.

• Accompanying website offers additional projects, expanded tutorials, and 
other valuable learning tools.

COMPLETED PROJECTS AND TUTORIALS 
FROM EACH CHAPTER IN APPENDIX A

You will fi nd all completed projects and tutorials at the end of this book as 
Appendix A. It provides a great visual reference of the depth of these challenging 
projects and tutorials that you will be creating, and having fun while learning!
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Find All Your Completed Projects in Appendix A

Soldier photo courtesy of Carla Clancy, The Lobster Catch News Text and images courtesy of Shelly 
Britton, remainings images courtesy Cengage Learning 2013.
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HOW TO USE THIS TEXT

OBJECTIVES

Learning Objectives start off each chapter. They describe the competencies 
readers should achieve once they understand the chapter material.

DESIGN AND TOOLKIT TIPS

These tips are located throughout the text. Design Tips show readers how to 
master design techniques, and Toolkit Tips demonstrate how to work more 
effi ciently and effectively within each software application.

CLIENT ASSIGNMENTS

These projects involve multiple tools and techniques and resemble assign-
ments that a designer might encounter on the job.

REVIEW QUESTIONS

Review Questions are located at the end of each chapter and allow readers to 
assess their understanding of the material.

ADVANCED USERS AND DIGITAL TOOLKIT EXTRA SECTIONS

These tutorials are located at the end of each chapter and provide added chal-
lenges using additional tools and techniques. 

UNIT REVIEW PROJECTS

These projects link together all chapters within a unit and utilize a few addi-
tional functions or techniques.

THE LEARNING PACKAGE

INSTRUCTOR RESOURCES

The online instructor resources were developed to assist instructors in planning 
and implementing their instructional programs. They include all the fi les needed 
for the projects and assignments, PowerPoint presentations, and some extra 
projects and information in an “Extras & Goodies” folder. These resources also 
include exams, review questions and answers from each chapter, syllabi, web 
references, additional assignments, and concept information. These resources 
can be found online at: http://login.cengage.com. Once you login or create 
an account, search for the title under “My Dashboard” using the ISBN. Then 
select the instructor companion site resources and click “Add to my Bookshelf.”
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C h a p t e r 

1
CHAPTER OBJECTIVES: To understand 
how to be productive in a graphics 
environment, in this chapter you will:

� Learn the basics of the Mac OS X Mavericks, 
Windows 7, and Windows 8 operating systems and 
techniques that allow Mac OS X and Windows to 
work together.

� Use basic fi le management techniques to help 
organize workfl ow.

� Learn keystroke combinations to increase 
productivity.

� Use new fun applications and techniques to keep 
your desktop from becoming too cluttered.

� ADVANCED USERS: Create electronic slide shows of 
images using special applications within Macintosh 
OS X and Windows operating systems. 

� DIGITAL TOOLKIT EXTRA: Burn music, photo, and 
data CDs on Mac OS X and Windows platforms 
using free programs within each. Use iCloud to 
manage your music, images, and documents.

Welcome 
to the 
Land of OS
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Before we get into the various graphics applications, we will start by getting 

comfortable with Macintosh and Windows operating systems. An oper-

ating system—sometimes referred to as an OS—makes sure hardware 

and software work together nicely. Applications are software programs 

for a particular use, such as Photoshop, which is an application used for 

digital image editing. For instance, if you want to print an image created in 

Photoshop, you click on the command to print, and the operating system 

sets up the communications between the application and the printer to print 

the document accurately. This chapter will familiarize you with the basics of 

the Macintosh OS X, or Mac OS X, and Windows 7 and Windows 8

operating systems and some of their included special applications. There 

are tips on using both systems together to manage your fi les and down-

loading the student data fi les for the chapter exercises, which will help you 

develop skills to improve your productivity as a designer or photographer.

THE MAC OS X ENVIRONMENT

Welcome to the operating system of the graphics industry: Mac OS X. You will 
notice similarities between the Mac OS X desktop—the screen displayed when 
the system has loaded—and the Windows 7 and Windows 8 desktop screens. Both 
Macintosh and Windows operating systems display your drives, portable media 
devices, and most frequently used applications, fi les, and folders on your com-
puter screen as small picture representations, called icons (see Figure 1-1). When 
you double-click on an icon, it opens up that fi le, folder, or application; it is actu-
ally a link, or shortcut, that you can create as an alias on your desktop. 

At the bottom of the Mac desktop—or sometimes to the left or right side, depend-
ing on your System Preferences settings—is the Dock, which is used to display 
applications, fi les, and folders. The Trash icon is used to remove and restore fi les. 
The Finder menu (sometimes referred to as the desktop menu) at the top of the 
screen lets you navigate the computer; it also appears as a square, smiling face on 
the Dock. Each application has its own menu bar and commands to perform tasks. 
You can also transfer and store folders and their contents on the desktop for quick 
access, or you can click on the icon in the Dock.
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Mission Control

Finder Dashboard

Face Time
(video chat) iCal

System
Preferences

Photoshop
(active)

iTunes
(alias)

Current active
windows minimized

Launchpad
App Store

Safari
Address Book iPhoto Illustrator InDesign Dowload and 

Document Folders
(click to expand as stacks)

Trash

THE DOCK

The Dock can be set to reside at the bottom, side, or even out of view off the edge 
of your screen (see Figure 1-2). It can contain images, minimized windows, fold-
ers, applications, documents, and even links to websites. Each item stored on the 
Dock has its own icon. Click on the icon and the Dock restores the window in your 
workspace or launches the application. When you open an application, that applica-
tion’s icon appears on the Dock. You’ll fi nd a white dot displays underneath when 
an application is active. Your favorite applications can be set to remain on the Dock, 
even after the computer has been turned off. You will also see the Trash icon on the 
right side or bottom of the Dock. Besides using it to remove and restore fi les, it can 
be used to eject drives, portable media devices, and CDs. On the left side of the Dock 
is the smiling Finder interface; its desktop menu commands are also at the top of the 
screen. You will fi nd that most standard Mac OS X application icons—except for the 
Trash icon—will be displayed on the left side or top of the Dock, and minimized fi les 
will appear to the right. The Mac OS X  version displays a “Documents” folder for 
your most recent documents to retrieve, or you can simply create your own folder. 
Any folder placed on the Dock’s right side can be used as part of a feature called 
“stacks.” When you click a stack folder, it springs from the Dock to display the 
folder contents. To open a fi le in a stack, just click on it. To remove it, just drag it into 
the Trash. You may also fi nd, on the right side of the Dock, a Downloads folder desig-
nated by the downward pointing arrow for quick access to downloaded applications 
or fi les. On the left side of the Dock you‘ll fi nd an application called the Launchpad, 
which displays all the Mac‘s current installed applications when you click on it.

� FIGURE 1-2 

The Dock displays 
applications, fold-
ers, fi les, and func-
tions. Icons on 
the leftmost side 
are applications in 
Mac OS X, while 
“stacks” and mini-
mized windows 
reside on 
the right side.

� FIGURE 1-1

The Macintosh OS X 
Mavericks desktop.

Cover Flow View

Hard Drvie Icon

CD Icon

Application Alias

File Icon

Document Icon

Folder Icon

Flash Drive Icon

Displaying “stacks” of
files from Document folder

Double-clicking the “Hard Drive icon
will display contents in the window

Finder (Desktop) Menu Bar

The Dock displays applications and active files Trash
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Minimize
Close Full Size/Restore

View icons

Quick Look
(full screen preview)

Additional media storage
and devices

Special tasks
or actions

Display contents (Column View)

- +

Look for files

� FIGURE 1-3 

Mac windows used 
to locate and modify 
fi les and folders.

TOOLKIT TIP To remove an application from the Dock, click the application 
icon and hold it until a pop-up menu appears; when the menu bar displays for
that application, select Remove from Dock. If a shortcut or alias is created, it will have 
a broken arrow under the icon and can simply be dragged off the Dock; the icons 
are just links and do not affect the original application, which can be found in the 
Applications folder (Go > Applications).

MAC OS X WINDOWS

In Mac OS X, windows that are opened to locate contents in folders or drives 
display a weblike page (default view), where you can use back and forward arrow 
buttons to move between windows and previous documents (see Figure 1-3). 
You can also select one of four View buttons to choose how you want the content 
displayed. These functions appear on the window toolbar, which shows special 
commands and functions for each application.

All windows have a title bar that contains the fi le or function name and three colored 
buttons on the left side that control how the window displays. The red button closes 
the window, the yellow button minimizes the window to an icon on the Dock, and 
the green button increases the window to its full size or restores it to its original state. 
To resize the window, click and drag the lower right corner. Sometimes when you 
select a command or function, indicated by a gearlike icon called the Action button, 
a dialog box appears to provide more commands or functions. In current Mac OS X 
versions, you can observe a full screen preview of any image or document by select-
ing the document, and clicking the eye icon on the Toolbar called “Quick Look.” To 
customize your toolbar with specifi c actions, with your cursor over the toolbar, hold 
down the CTRL key and select Customize from the display panel.
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THE HARD DRIVE

To display the contents of your hard drive, double-click on the Macintosh HD 
or hard drive icon on the desktop. On the toolbar, you will notice the View but-
ton, which lets you choose between displaying in Icon View, List View, Column 
View,  and Cover Flow View. Column View makes it easy to navigate between 
drives, folders, and fi les; the contents of whatever is highlighted are displayed in 
the next column to the right (see Figure 1-4). When you select a folder, you will 
notice its contents are displayed. Cover Flow View shows graphic thumbnail rep-
resentations of your fi les and documents.

The left side column of the window displays Documents links and storage media—
such as your hard drive and network connections—and organizes specifi c links to 
your desktop, your “Home” space for your personal fi les on the computer, and 
available applications, including those that were included with Mac OS X. There 
are specifi c media categories for your fi les and folders, such as Movies, Music, and 
Pictures to maintain peak computer performance. You can also search for previ-
ously used documents and applications. There is a category called All My Files, 
which puts all your personal music, images, documents, etc., in specifi c categories 
for quick access.

Now, we will learn to navigate around the Macintosh HD or hard drive icon.

 1. Double-click on the Macintosh HD or hard drive icon on your desktop. 

 2. Select the Home icon (next to your username) link for your personal settings, 
fi les, and so on; locate a folder and display its contents, then use the back and 
forward arrow buttons to move around.

 3. Select the All My Files and Applications buttons to display their contents.

 4. Select the Desktop and Documents buttons and select the four different views 
on the toolbar to see how contents are displayed.

 5. Navigate around a little, then close the window. 

List View

Icon Column View

Home
(User)

Storage Devices

Media Storage

Cover Flow View Arranging
File Display

� FIGURE 1-4 

Options to locate, 
edit, and organize 
fi les and folders of 
various media on 
your hard drive or 
device.

DESIGN TIP
To resize a window 
proportionately 
when it is not dis-
played as a full 
screen on your 
monitor, hold down 
the Shift key while 
you drag from the 
window’s lower right 
corner point. 

TOOLKIT TIP If you are not sure what some of the icons mean on the toolbar, 
press the CTRL key, then click to display a menu, then choose “Icon and Text” to 
display both.
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MAC OS X FINDER DESKTOP MENUS

The Mac OS X Finder interface on the desktop works much the same way as 
the Start menu does in Windows. It provides access to particular functions for 
applications, fi les, folders, and computer using a Menu bar, which contains com-
mands from various menus specifi c to the Finder desktop interface shown here 
(see Figure 1-5) or for any other application, such as Photoshop. 

The Apple Menu

The Apple menu is where you can fi nd information about your Mac system ( > 
About This Mac) and fi les, which includes a listing of the most recently opened 
applications and fi les; you can also set global, System Preferences here and check 
for software updates. Use the About My Mac link to check what version you are 
using. If you are using the current Mavericks version, you’ll fi nd it reads 10.9 ver-
sion. To avoid damaging data and software by turning off the power to your Mac, 
use the Restart or Shut Down commands under this menu to power down your 
Mac safely. 

The Finder Menu

The Finder menu lets you organize how icons are displayed and set desktop pref-
erences. This is where you fi nd the Empty Trash command to permanently remove 
fi les dragged into the Trash.

Proper methods
to put your Mac to 
Sleep, Restart it, or
Shut Down your Mac.

Finder Menu Bar� FIGURE 1-5 

Apple, Finder, 
and File menus 
in Finder desktop 
menu bar.

Copyright 2015 Cengage Learning. All Rights Reserved. May not be copied, scanned, or duplicated, in whole or in part. Due to electronic rights, some third party content may be suppressed from the eBook and/or eChapter(s).

Editorial review has deemed that any suppressed content does not materially affect the overall learning experience. Cengage Learning reserves the right to remove additional content at any time if subsequent rights restrictions require it.



 WELCOME TO THE LAND OF OS 9

The File Menu

The File menu allows you to create new folders, search for and get info about fold-
ers and fi les, duplicate items, and create links or shortcuts to fi les and  folders, called 
aliases. In this menu, you can eject discs, burn CDs, and move fi les to the Trash.

Some of the special commands in the File menu are described below.

• Get Info gives details, such as date and size, about a selected icon.

• Make Alias makes an alias, shortcut, or link to a fi le, document, or folder, 
which can be dragged onto the desktop.

• New Smart Folder helps you to organize fi les by what they have in common 
based on criteria you set.

• New Burn Folder allows you to create a collection of fi les to be burned or 
written onto a CD or DVD multiple times.

• New Tab allows you to consolidate various open Finder windows into one.

• Add to Dock allows you to add fi les, folders, and applications to the sidebar 
for quick access. To remove, press down the CTRL key and select Remove From 
Sidebar. This is similar to adding favorites on the Internet Explorer web browser.

• Move to Trash moves selected fi les and folders to the Trash icon on the Dock.

• Find locates fi les and folders through specifi c criteria in Home through 
category links.

• Tags (or Label in earlier versions) helps to organize groups of fi les by assign-
ing color labels and keywords.

The Edit Menu

The Edit menu allows you to work with text and graphics, which includes select-
ing all components in a document (see Figure 1-6). It allows you to undo, copy, 
cut and paste, and see what is copied on the clipboard. The clipboard is a tem-
porary memory site for storing text and graphics that have been cut or copied 
before pasting them into another document or to another location. Since the clip-
board only “remembers” one thing at a time, anytime you cut or copy something 
else, the content of the clipboard is replaced by the new data.

� FIGURE 1-6 

Edit, View, and 
Window menus 
on Finder desktop 
menu bar.
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